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1.  INTRODUCTION

The BL2000 is a high-performance, C-programmable single-

board computer that offers built-in digital and analog I/O com-

bined with Ethernet connectivity in a compact form factor. A

Rabbit® 2000 microprocessor operating at 22.1 MHz provides

fast data processing. An optional plastic enclosure is available,

and may be wall-mounted or panel-mounted.

1.1  BL2000 Description

The BL2000 is an advanced single-board computer that incorporates the powerful Rabbit 

2000 microprocessor, flash memory, static RAM, digital I/O ports, A/D converter inputs, 

D/A converter outputs, an SPDT relay output, and a 10Base-T Ethernet port.

1.2  BL2000 Features

• Rabbit® 2000 microprocessor operating at 22.1 MHz.

• 128K static RAM and 256K flash memory.

• Up to 28 digital I/O:

11 protected digital inputs (plus up to 7 dual-purpose unbuffered analog inputs that 

may be software-configured for use as digital inputs) and 10 high-current digital 

sinking outputs that may be factory-configured as sourcing outputs.

• 11 analog channels: nine 12-bit A/D converter inputs, two 12-bit D/A converter outputs.

• Onboard SPDT relay.

• One RJ-45 Ethernet port compliant with IEEE 802.3 standard for 10Base-T Ethernet 

protocol.

• Eight status LEDs.

• 4 serial ports (2 RS-232 or 1 RS-232 with RTS/CTS, 1 RS-485, and 1 CMOS-compati-

ble programming port).

• Real-time clock.

• Watchdog supervisor.

• Voltage regulator.
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• Backup battery.

• Ability to send e-mail and serve Web pages containing embedded data from single-

board computer.

• Remote program downloading and debugging capability via RabbitLink.

• Boards with the CE mark are CE-compliant.

• Optional plastic enclosure (can be wall-mounted or panel-mounted) and LED light 

pipes (enclosure and light pipes are included with the Tool Kit, and are also sold sepa-

rately).

Appendix A provides detailed specifications.

Four models of the BL2000 are available. Their standard features are summarized in 

Table 1.

1.2.1  Connector Options

In addition to the standard screw-terminal connectors supplied on BL2000 boards, IDC 

headers, bottom-mount connectors, and polarized friction-lock terminals may be factory-

installed instead. Visit our Web site at www.rabbit.com or contact your Rabbit sales repre-

sentative or authorized distributor for further information.

Table 1.  BL2000 Series Features

Model Features

BL2000 Full-featured single-board computer.

BL2010
BL2000 with eleven 10-bit A/D converter inputs (no D/A 

converter outputs).

BL2020 BL2000 without Ethernet interface, only 6 LEDs.

BL2030 BL2010 without Ethernet interface, only 6 LEDs.

Standard screw terminals, accept 

up to 14 AWG (1.5 mm2) wire

“Bottom-mount connector” to 

mount BL2000 directly on 0.1" 

pitch pins located on motherboard

2 × 17 IDC headers, 0.1" pitch
Polarized friction-lock terminals, 

0.1" pitch
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1.3  Development and Evaluation Tools

1.3.1  Tool Kit

A Tool Kit contains the hardware essentials you will need to use your own BL2000 single-

board computer. The items in the Tool Kit and their use are as follows:

• Getting Started instructions.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Programming cable, used to connect your PC serial port to the BL2000.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., 

U.K., and European style plugs).

• Demonstration Board with pushbutton switches and LEDs. The Demonstration Board 

can be hooked up to the BL2000 to demonstrate the I/O.

• Wire assembly to connect Demonstration Board to BL2000.

• Plastic enclosure with four screws and eight customer-installable light pipes.

• Screwdriver.

• Rabbit 2000 Processor Easy Reference poster.

• Registration card.

Figure 1.  BL2000 Tool Kit

Rabbit and Dynamic C are registered trademarks of Digi International Inc.

Wildcat (BL2000)

The BL2000 provides optional Ethernet connectivity in a low-cost, high-performance single-board 

computer rich with the digital I/O, A/D, and D/A designers need for embedded control and monitoring 

applications on a compact board. These Getting Started instructions included with the Tool Kit will 

help you get your BL2100 up and running so that you can run the sample programs to explore its capa-

bilities and develop your own applications.

Tool Kit Contents

The BL2000 Tool Kit contains the following items:

• Dynamic C CD-ROM, with complete product documentation on disk.

• Programming cable, used to connect your PC serial port to the BL2000.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and 

European style plugs).

• Demonstration Board with pushbutton switches and LEDs. The Demonstration Board can be 

hooked up to the BL2000 to demonstrate the I/O.

• Wire assembly to connect Demonstration Board to BL2000.

• Plastic enclosure with four screws and eight customer-installable light pipes.

• Screwdriver.

• Getting Started instructions.

• Rabbit 2000 Processor Easy Reference poster.

• Registration card.

Visit our online Rabbit store at www.rabbit.com/store/ for the latest information on peripherals and 

accessories that are available for the BL2000 single-board computers.

Step 1 — Install Dynamic C®

Before doing any development, you must install Dynamic C. Insert the CD from the Development Kit in 

your PC’s CD-ROM drive. If the installation does not auto-start, run the setup.exe program in the root 

directory of the Dynamic C CD. Install any Dynamic C modules after you install Dynamic C.
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1.3.2  Software

The BL2000 is programmed using version 7.04 or later of Rabbit’s Dynamic C. A compat-

ible version is included on the Tool Kit CD-ROM. Dynamic C v. 9.60 includes the popular 

µC/OS-II real-time operating system, point-to-point protocol (PPP), FAT file system, 

RabbitWeb, and other select libraries that were previously sold as individual Dynamic C 

modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure 

Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-

tion to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. Visit our Web site at 

www.rabbit.com for further information and complete documentation, or contact your 

Rabbit sales representative or authorized distributor.
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1.4  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequen-

cies above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-

based systems at frequencies above 300 MHz are generally well below background noise 

levels.

The BL2000 single-board computer has been tested and was found to 

be in conformity with the following applicable immunity and emission 

standards. The BL2010, BL2020, and BL2030 single-board computers 

are also CE qualified as they are sub-versions of the BL2000 single-

board computer. Boards that are CE-compliant have the CE mark.

NOTE: Earlier versions of the BL2000 sold before 2003 that do not have the CE mark 

are not CE-compliant.

Immunity

The BL2000 series of single-board computers meets the following EN55024/1998 immu-

nity standards.

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The BL2000 series of single-board computers meets the following emission standards 

using the enhanced-EMI PCB, Part# 175-0224 Rev. A, and the 668-0003 Rev. A Rabbit 

2000 microprocessor.

• EN55022:1998 Class B

• FCC Part 15 Class B 

Your results may vary, depending on your application, so additional shielding or filtering 

may be needed to maintain the Class B emission qualification.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1  µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m
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1.4.1  Design Guidelines

Note the following requirements for incorporating the BL2000 series of single-board com-

puters into your application to comply with CE requirements.

General

• The power supply provided with the Tool Kit is for development purposes only. It is the 

customer’s responsibility to provide a CE-compliant power supply for the end-product 

application.

• When connecting the BL2000 single-board computer to outdoor cables, the customer is 

responsible for providing CE-approved surge/lighting protection.

• Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a 

metal conduit to assist in maintaining CE compliance and to conform to good cable 

design practices.

• When installing or servicing the BL2000, it is the responsibility of the end-user to use 

proper ESD precautions to prevent ESD damage to the BL2000. 

Safety

• All inputs and outputs to and from the BL2000 series of single-board computers must 

not be connected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

• The lithium backup battery circuit on the BL2000 single-board computer has been 

designed to protect the battery from hazardous conditions such as reverse charging and 

excessive current flows. Do not disable the safety features of the design.

1.4.2  Interfacing the BL2000 to Other Devices

Since the BL2000 series of single-board computers is designed to be connected to other 

devices, good EMC practices should be followed to ensure compliance. CE compliance is 

ultimately the responsibility of the integrator. Additional information, tips, and technical 

assistance are available from your authorized Rabbit distributor, and are also available on 

our Web site at www.rabbit.com.
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2.  GETTING STARTED

Chapter 2 explains how to connect the programming cable and

power supply to the BL2000.

2.1  BL2000 Connections

1. Attach the BL2000 to the plastic enclosure base.

Position the BL2000 over the plastic enclosure base as shown below in Figure 2. Attach 

the BL2000 to the base at the top left and bottom right positions using the two 4-40 × ¼ 

screws supplied with the enclosure.

Figure 2.  Attach BL2000 to Plastic Enclosure Base

The plastic enclosure base facilitates handling the BL2000 during development, and pro-

vides an attractive mounting alternative. Alternatively, you may wish to use standoffs to 

protect the components on the other side of the board. The plastic enclosure is offered as a 

separate option when individual BL2000 boards are purchased.

NOTE: Appendix B, “Plastic Enclosure,” provides additional information and specifications 

for the plastic enclosure.
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2. Connect the programming cable to download programs from your PC and to debug the 

BL2000.

Connect the 10-pin PROG connector of the programming cable to header J5 on the BL2000. 

Ensure that the colored edge lines up with pin 1 as shown. (Do not use the DIAG connector, 

which is used for a normal serial connection.) Connect the other end of the programming 

cable to a COM port on your PC.

Figure 3.  Programming Cable Connections

NOTE: Never disconnect the programming cable by pulling on the ribbon cable. Carefully 

pull on the connector to remove it from the header.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an 

RS-232/USB converter (Part No. 20-151-0178) with the programming cable supplied with 

the Tool Kit. Note that not all RS-232/USB converters work with Dynamic C.
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3. Connect the power supply.

First, prepare the AC adapter for the country where it will be used by selecting the plug. 

The BL2000 Tool Kit presently includes Canada/Japan/U.S., Australia/N.Z., U.K., and 

European style plugs. Snap in the top of the plug assembly into the slot at the top of the 

AC adapter as shown in Figure 4, then press down on the spring-loaded clip below the 

plug assembly to allow the plug assembly to click into place.

Connect the bare ends of the power supply to the +RAW and GND positions on screw-

terminal header J2 as shown in Figure 4.

Figure 4.  Power Supply Connection

4. Apply power.

Plug in the AC adapter. If you are using your own power supply, it must provide 9 V to 40 V 

DC—voltages outside this range could damage the BL2000.

CAUTION: Unplug the power supply while you make or otherwise work with the connections 

to the headers. This will protect your BL2000 from inadvertent shorts or power spikes.

NOTE: The green PWR LED and the red BAD LED on the opposite end of the board 

should come on, indicating that the BL2000 is now ready to be used.

NOTE: A hardware RESET is done by unplugging the AC adapter, then plugging it back in, 

or by momentarily grounding the board reset input at pin 9 on screw-terminal header J2.
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2.2  Installing Dynamic C

If you have not yet installed Dynamic C version 7.04 (or a later version), do so now by 

inserting the Dynamic C CD in your PC’s CD-ROM drive. The CD will auto-install unless 

you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and 

browse for the Dynamic C setup.exe file on your CD drive. Click OK to begin the 

installation once you have selected the setup.exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of 

Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default installation 

of the later version will be in a different folder, and a separate icon will appear on your desk-

top.
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2.3  Starting Dynamic C

Once the BL2000 is connected to your PC and to a power source, start Dynamic C by 

double-clicking on the Dynamic C icon on your desktop or in your Start menu.

Dynamic C defaults to using the serial port on your PC that you specified during installa-

tion. If the port setting is correct, Dynamic C should detect the BL2000 and go through a 

sequence of steps to cold-boot the BL2000 and to compile the BIOS. (Some versions of 

Dynamic C will not do the initial BIOS compile and load until the first time you compile a 

program.)

If you are using a USB port to connect your computer to the BL2000, choose Options > 

Project Options and select “Use USB to Serial Converter.” Click OK.

If you receive the message No Rabbit Processor Detected, the programming 

cable may be connected to the wrong COM port, a connection may be faulty, or the target 

system may not be powered up. First, check both ends of the programming cable to ensure 

that it is firmly plugged into the PC and the programming port.

If there are no faults with the hardware, select a different COM port within Dynamic C. 

From the Options menu, select Communications. Select another COM port from the list, 

then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C 

still reports it is unable to locate the target system, repeat the above steps until you locate the 

active COM port. You should receive a Bios compiled successfully message 

once this step is completed successfully. 

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can 

begin debugging,  it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Choose a lower debug baud rate.
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2.4  PONG.C

You are now ready to test your set-up by running a sample program.

Find the file PONG.C, which is in the Dynamic C SAMPLES folder. To run the program, 

open it with the File menu (if it is not still open), compile it using the Compile menu, and 

then run it by selecting Run in the Run menu. The STDIO window will open and will dis-

play a small square bouncing around in a box.

This program does not test the serial ports, the I/O, or the TCP/IP part of the board, but 

does ensure that the board is basically functional. The sample program described in 

Section 5.3, “Run the PINGME.C Sample Program,” tests the TCP/IP portion of the 

board.

2.5  Where Do I Go From Here?

NOTE: If you purchased your BL2000 through a distributor or Rabbit partner, contact the 

distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to explore other BL2000 fea-

tures and develop your own applications.

Chapter 3, “Subsystems,” provides a description of the BL2000’s features, Chapter 4, 

“Software,” describes the Dynamic C software libraries and introduces some sample pro-

grams, and Chapter 5, “Using the TCP/IP Features,” explains the TCP/IP features.
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3.  SUBSYSTEMS

Chapter 3 describes the principal subsystems for the BL2000.

• Digital I/O

• Relay Outputs

• Serial Communication

• A/D Converter Inputs

• D/A Converter Outputs

• Memory

• External Interrupts

Figure 5 shows these Rabbit-based subsystems designed into the BL2000.

Figure 5.  BL2000 Subsystems
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3.1  BL2000 Pinouts

The BL2000 pinouts are shown in Figure 6(a) and Figure 6(b).

Figure 6(a).  BL2000 Pinouts (screw-terminal headers)
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3.1.1  Headers and Screw Terminals

All BL2000 models are equipped with 1 × 12 screw terminal strips (J2, J4, J8, and J9) and 

a 2-pin power jack (J7). The BL2000 and BL2010 also have the RJ-45 Ethernet jack (J6).

There is provision on the circuit board to accommodate one of the following types of 

connectors instead of the screw-terminal strips.

• 2 × 17 IDC headers with a pitch of 0.1".

• 1 × 17 friction-lock connectors with a pitch of 0.1".

• 1 × 17 bottom-mount sockets with a pitch of 0.1". The holes for the bottom-mount 

sockets are on the “outside” edges of the connector locations

The pinouts for these connectors are shown in Figure 6(b).

Figure 6(b).  BL2000 Pinouts (other 0.1" headers)
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3.1.2  Power Supply Pins

Instead of connecting an AC adapter to the power supply jack, J7, the input power supply 

(9 V to 40 V DC) may be connected to pins 12 and 11 on header J2 (see Figure 6(a) or 

Figure 6(b)).

Pin 12 on header J9 or J10 is normally GND by factory default, but may be changed to 

Vcc by removing resistor R161 and installing resistor R160. See Appendix C, “Power 

Supply,” for more information on this configuration and for information on backup-

battery options.
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3.2  Digital I/O

3.2.1  Digital Inputs

The BL2000 has 11 digital inputs, IN0–IN10, each of which is protected over a range of 

–36 V to +36 V. The inputs are factory-configured to be pulled up to +5 V, but they can 

also be pulled down by moving the surface-mounted jumper at JP6 as shown in Figure 7.

Figure 7(a).  BL2000 Digital Inputs [Pulled Up—JP6(1–2) connected]

Figure 7(b).  BL2000 Digital Inputs [Pulled Down—JP6(2–3) connected]
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Figure 7(c).  Example of Logic Gate Driving BL2000 Digital Input

The actual switching threshold is approximately 2.40 V for channels IN0–IN10. Anything 

below this value is a logic 0, and anything above is a logic 1.

The A/D converter inputs can be used as additional digital inputs using the parameters 

specified for the digIn software function call. The default threshold for channels IN11–

IN21 is also set to 2.40 V, but may be changed by adding two lines to your program as dis-

cussed for the digIn software function call.

The digital inputs are each fully protected over a range of -36 V to +36 V, and can handle 

short spikes of ±40 V.

Figure 8.  BL2000 Digital Input Protected Range
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3.2.2  Digital Outputs

The BL2000 has 10 digital outputs, OUT0–OUT9, each of which can either sink or source 

up to 200 mA, depending on how the outputs are configured. On boards that carry the CE 

mark, OUT8 and OUT9 are each capable of sinking up to 750 mA.

Each output can be configured individually as either a sinking or a sourcing output as shown 

in Figure 9. The outputs can be pulled as a group to Vcc, +K, or GND through 27 kΩ resis-

tors. Tie the outputs high to either Vcc or +K when using the outputs as sinking outputs (via 

0 Ω resistors at R32 or R35 respectively), or tie the outputs to GND via R34 when using the 

outputs as sourcing outputs. +K is an externally supplied voltage of up to 40 V DC, and is 

used primarily in combination with current sourcing outputs, and must also be connected to 

an external supply when an inductive load is connected to a sinking output.

NOTE: Remove the 27 kΩ resistors (R143–R150) from the output circuits if no pull-

up/down is required to avoid leakage between the outputs. These resistors are located 

on the bottom side of the BL2000 board above the solder points for screw terminal 

header J9.
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Figure 9.  BL2000 Digital Outputs

The locations of the output pull-up/pull-down select resistors R32, R34, and R35 are 

shown in Figure 10.

Figure 10.  Locations of Resistors R32, R34, and R35

All BL2000 models are factory-configured with sinking outputs and pull-up resistors tied 

to Vcc via a 0 Ω resistor at R32.
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3.3  Relay Outputs

Figure 11 shows the BL2000 relay contact connections. A diode across the coil provides a 

return path for inductive spikes, and snubbers across the relay contacts protect the relay 

contacts from inductive spikes.

Figure 11.  BL2000 Relay Output Contact Connections

The relay is driven by PA0, which is the same Rabbit 2000 parallel port that drives OUT0 

and LED DS4. OUT0 therefore works in parallel with the relay output.

The relay included on the BL2000 has contacts rated for 1 A @ 30 V DC or 300 mA @ 

120 V AC. When using the BL2000 in a CE-certified application, the voltages handled by 

the relay must not exceed SELV levels (42.4 V AC peak, or 60 V DC).
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